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Abstract
With an increasing human population, it is the challenge to create a circular agrofood system
where enough food is produced without running out of the Earth’s resources. Cover crops
play an important role in a sustainable agriculture because they maintain soil quality and
prevent nitrogen leaching loss. Moreover, with the right use of cover crops, crop height can be
improved and therefore yield can be maximized. The concept where a plant influences the soil
properties where the subsequent crop encounters effect from is called plant-soil feedback
(PSF).
In this study, the effects of an experiment with three different cover crops, consisting of vetch,
radish, and oat, and mixtures of them, together with a fallow plot were analysed on the
subsequent crop, spring barley. The objective of this study was to evaluate whether
multispectral UAV data can be used to get insight into the system of the crop growth of spring
barley and examine the effects of treatments of the cover crop in the context of PSF. Here, the
focus was on crop height, since this can influence the yield. Crop height was measured in the
field to gather ground-truth information. Also, multispectral data were acquired with an
unmanned aerial vehicle (UAV), resulting in five moments to analyse during the barley
growth period. The raw UAV data was processed with Structure from Motion (SfM)
photogrammetry, where a best-practices workflow was created to generate Digital Elevation
Models (DEM) with high accuracy. The accuracy of UAV derived crop height highly depends
on ground-truth information available and the possibility to match them in photogrammetric
software. This was not the case for a selection of GCPs, resulting in more uncertainty around
these locations. Therefore, the number of plots available for analysis had to be reduced from
40 to 24.
With thresholds on the Normalized Differenced Vegetation Index (NDVI) and the Crop Height
Model (CHM), soil and other objects present in the plots were excluded, leaving only
vegetation in the data. Especially early in the growing season this had to be excluded, since
the plants did not cover the plots with vegetation. With a R2 of 0.91 and a RMSE of 7.11, the
UAV derived crop height correlates well with the ground-truth information in all stages over
the growing season. However, later in the growing season when crop height is larger, larger
deviations exist. Mixtures of cover crops together with the single radish treatment resulted in
the largest crop height. Moreover, the fallow treatment proved to have a substantially lower
crop height. These results prove that it is possible to measure the effects of PSF in a nondestructive manner.
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Introduction
Context and Background
The impact of the current global food system is enormous. If this won’t change in the coming
years, the physical limits of the earth will be exceeded (Page, 2020). Therefore it is the challenge
in the coming years to create a circular agrofood system where enough food is produced for
the increasing world population without running out of the Earth’s resources (De Boer & Van
Ittersum, 2018).
Cover crops play an important role in maintaining soil quality by providing ground cover for
the soil to prevent water and wind erosion and for minimizing agricultural impact on
environmental change (Reicosky & Forcella, 1998). Choosing the right cover crop is very
important taking into account nitrogen leaching loss (Tian et al., 2018). Moreover, cover crops
can also be used to stimulate the following crop that will grow, in this case spring barley
(Hordeum vulgare) in 2019. Plants influence the soil and its properties where they are grown.
The following plant that grows on the same location encounters effect of the of the first plant
that grew there (Pernilla Brinkman et al., 2010). This concept is called plant-soil feedback (PSF).
In agriculture, PSF can positively influence crop growth, and thus result in a higher yield,
when the right crop rotations are used. The majority of PSF studies are performed under
controlled conditions in greenhouses or laboratories. Therefore it is needed to test PSF under
field conditions, in order to make it scalable for the whole farming system and to assess the
knowledge of PSF in controlled conditions (Putten et al., 2013). Moreover, cover crops have
the potential to improve sustainability in agriculture (Kertész & Madarász, 2014).
Originally, satellites were used to collect remote sensing measurements of for example
agricultural fields. However, the spatial resolution of satellites is often too low to perform
precision agriculture, as well as the temporal resolution because they orbit the earth which
makes it unable to choose the moment of data being captured. Thanks to technical
developments in the past years, lightweight multispectral sensors have become available for a
larger user community. Unmanned Aerial Vehicles (UAVs) can carry these sensors to offer
remote sensing tools for precision farming, with the goal to maximize the yield and minimize
the use of resources (Näsi et al., 2018). The advantages of the use of UAVs are the efficient,
flexible and non-invasive solution it offers for time-sensitive measurements (Han et al., 2018).
Multispectral sensors, like the commercial Parrot Sequoia, can measure different spectral
bands and make it possible to measure the nitrogen/chlorophyll content or crop height (Jones
et al. 2007; Handique et al. 2017). This sensor measures the reflectance of four spectral bands:
green, red, red-edge and NIR infrared. Moreover, with Structure from Motion (SfM)
photogrammetry it is possible to generate elevation models, from where crop height can be
calculated. Because it is very compact, it is compatible with several types of UAVs.

Problem definition
To evaluate the effects of PSF in the Clever Cover Cropping project, field observations were
used to measure the crop height. The effects of PSF are evaluated on crop height, because this
can say something about its yield. Often, field measurements happen on a limited number of
times in a destructive way that damages the crops. In an experimental setup there is less risk
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on damaging the crops since it consists of small plots. However, it is more difficult to enter a
large field with crops without damaging it. Sensors attached on UAVs can offer a solution for
this by making it possible to gather information of the crops in a non-destructive way and do
more measurements over the whole growing season in less time. Research needs to be done if
this non-destructive method can replace the destructive method in the future, with
measurements of sufficient quality.
In a previous thesis this year on spring barley, crop height was measured 8 times during the
growing season (Nascimento, 2019). These measurements are very important since they allow
remotely sensed data to be related with real features or materials on the ground. Often, ground
truth measurements are way more accurate than measurements of the system that is tested
(Egoyan, 2017). A previous research by Di Gennaro et al. (2018) shows promising correlations
between remote and ground-truth derived vegetation indices for barley plots. Thanks to the
latest technical developments, the emphasis in agriculture moves from field level towards
plant level accuracy. With UAVs different phenotypic traits can be acquired, such as crop
height that is used in this study. Crop height can be derived from a Canopy Height Model
(CHM) by subtracting the Digital Terrain Model from the Digital Surface Model generated
from 3D point clouds using structure from motion (SFM) techniques (Cunliffe et al., 2016). In
previous studies, statistical methods to compare field measurements with UAV data are used.
Especially in UAV-based crop parameter estimation studies, regression techniques are used
(Bendig et al., 2015; Geipel et al., 2016) where crop height can be used as predictors in the
regression model (Mileva, 2017). These regression models can be used to retrieve plant traits
from optical data (Van Der Meij et al., 2017). An issue for monitoring barley growth over time
are the characteristics of barley. Barley has a few development stages, that are mostly
influenced by photosynthesis, transpiration, leaf area, moisture, nutrition and leaf and root
diseases. (Vineberg, 2011). It is the challenge to recognise the different development stages
with the captured UAV data. The influencing factors on barley can also be related to the PSF
concept.

Objectives and research questions
The main objective is to evaluate whether multispectral UAV data can be used to get insight
in the system of the crop growth of spring barley and examine the effects of treatments of the
cover crop in the context of the PSF concept. The focus here is on crop height. Also there will
be investigated if the non-destructive way of gathering multispectral UAV data is comparable
with the destructive ground-truth measurements. Moreover, there will be evaluated if there is
a specific winter treatment that has the best effect on the performance of spring barley.
To execute this objective, the following research questions are set up:
RQ1: What method can be used to derive crop height of barley from multispectral imagery?
RQ2: What workflow could be used to create the best photogrammetric products in Agisoft
Metashape?
RQ3: Is the crop height information derived from multispectral data comparable with groundtruth measurements in all growing stages of spring barley, and can it replace these in the
future?
RQ4: What are the effects of the different cover crops on the following spring barley crop
height as observed from multispectral UAV data?
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Literature review
In this chapter the theoretical background of a few topics used for this study are explained. In
the coming paragraphs the plant-soil feedback concept, Structure from Motion, and crop
height model calculation are explained.

Plant-soil feedback
PSF is widely recognized as the influence plants have on the soil properties, even if the plant
is not there anymore (Pernilla Brinkman et al., 2010). Previous plants leave their mark in the
soil where a subsequent plant can benefit from. This is interesting, since it can also be used in
experiments for agriculture (Dias et al., 2014). In such an experiment, plants first influence the
soil composition. Hereafter, new plants grow in these influenced soils. The effects of the
influenced soils can be determined in several ways (Putten et al., 2013). Cover crops are mainly
used to prevent nutrient leaching (Hoffland, 2020; Tian et al., 2018). Moreover, cover crops are
a part of a sustainable agriculture since they help preserving the quality of the environment
and at the same time can help improve production (Barel et al., 2017; Lal et al., 1991). In
agriculture, cover crops are being used to keep nutrients and soil organic matter in the soil to
improve yield of the subsequent crop, resulting in a positive feedback (Barel, 2018; van der
Putten et al., 2016). It is also possible that the approach results in negative feedbacks that can
occur in a very dry season (Huang et al., 2013; Kardol et al., 2010). In this study, 3 cover crops
and mixtures of it are used as cover crop and barley as summer crop. The crop height of the
barley will be used to determine the effects of PSF. Mainly for agriculture, plant-soil relations
are very important to maximize yield. Climate change directly affects the mechanisms at the
core of plant-soil interactions (Ehrenfeld et al., 2005). Moreover, cover crops and crop rotations
can minimize the chance for weeds or invasive insects to settle (Pernilla Brinkman et al., 2010).
Because most PSF studies are done under controlled conditions, it is needed to do it under
field conditions to make it scalable in the future (Putten et al., 2013). Few studies have been
done to measure field-based PSF effects of cover crops with UAVs, enabling to nondestructively quantify plant traits responding to plant legacies in soil, with plant height as a
good estimator (Nuijten et al., 2019; Van Der Meij et al., 2017).

Structure from Motion
An increasing number of satellites orbit the earth, where a part of them make measurements
of the earth’s surface by taking pictures. However, these satellites cannot be used to derive
crop height because they have limited overlap, making it impossible to apply SfM. A solution
for that can be the use of high-resolution UAV imagery and photogrammetry to assess plant
traits. UAVs can gather information in a faster way than satellites and are useful for smaller
areas (Barnes, 2018).
Photogrammetry can be used to reconstruct the geometry of a photographed surface, where
information can be derived from. Photogrammetric stitching software makes use of SfM. This
technique makes it possible to create a 3D scene (structure) geometry from 2D static images
(motion). Figure 2.1 shows an illustration of SfM. SfM only results in good models when there
is an overlap of more than 60 percent (Mancini et al., 2013). Also, there is no robust
methodology for acquiring and processing images yet (Westoby et al., 2012). The elevation
models created with SfM can offer good estimations of crop height and volume. Specific
13

research to crop height derived from SfM is still scarce, although it becomes more widely
known (Cunliffe et al., 2016; Shahbazi et al., 2015). A previous study suggested that SfM of
UAV-based imagery was not suitable for measuring small plants, like grasses, because of
limitations in the accuracy of the CHMs (Zahawi et al., 2015). Several software packages for
SfM are available that also offer cloud-based processing, making it possible to process images
with a not to high-specification computer (Tonkin et al., 2014).

Figure 2.1: Illustration of the SfM technique that is able to make a 3D model from 2D images (VGM-CODE:
Structure from Motion with Objects (CVPR 2016), n.d.).

During photogrammetric processing of overlapping photographs a number of choices have to
be made. The accuracy during the alignment of the photos and the chosen density of the final
point cloud can for example be set. These choices may affect the final output and thus the
values that are derived from this output.

Crop height model calculation
Crop height can be derived from a CHM by subtracting the Digital Surface Model (DSM),
representing the highest elevation of a surface, from the Digital Terrain Model (DTM),
representing the elevation of the terrain, generated from (3D) point clouds using SfM
techniques, illustrated in Figure 2.2 (Cunliffe et al., 2016). This makes it possible to calculate
the crop height of the plots in the experiment. Another method is to interpolate the areas
between the plots of the DSM to retrieve an approximated ground surface DEM, also in the
areas covered with crops (Van Der Meij et al., 2017). Another method is to use the DEM data
from the Actueel Hoogtebestand Nederland (AHN), captured with a helicopter or airplane.
The most recent map of the AHN, the AHN3, has a resolution of 0.5m. Also, the DEM can be
extracted from UAV imagery before sowing or after harvesting, where you can assume that
the DSM is equal to the DEM in the crop area (Wu et al., 2017).
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The available data only consisted of a DSM, a DTM was lacking. There are several ways to
generate this DTM. In this research, the DSM of the data from the UAV flight performed on
04-01 was used as DTM, because this was one day before the barley was sown, so there was
no vegetation present in the plots of the study area. The DSM of the other dates were
subtracted from this DTM, resulting in CHMs.

Figure 2.2: Canopy Height Model calculation. Here, the DSM represents the highest elevation of a surface and the
DTM the elevation of the terrain, making it possible to calculate the height of the canopy and thus the crop height
of the plots in the experiment (Wasser, 2020).

15

Materials and Methods
Study Area
The study area (Figure 3.1) is located in the centre of The Netherlands, 500m to the North of
the campus of Wageningen University and Research (Lat 51.995123 Lon 5.660100). The test
field was planted, managed, and harvested by Unifarm. The area of the test field was
approximately 1,21 ha in size. The main crop grown was spring barley.

Figure 3.1: Overview map of the location of the study area in The Netherlands (left). RGB orthomosaic of the
study area derived from acquired RGB imagery of DJI Mavic Pro UAV on 14 June 2019 (right).

Set up of the experiment
The field experiment is part of a long-term project called Clever Cover Cropping of
Wageningen University and Research, started in August 2016. The main goal of this project is
to examine the effects of multiple combinations of cover crops on the following summer crops.
The cover crops planted were oat (Avena strigosa), radish (Raphanus sativus), and vetch (Vicia
sativa). The experiment consists of 5 blocks. Every block consists of 8 plots with a 10 m by 6 m
area each, where 7 plots contained the cover crops or bi- or tri-species mixtures with mixing
ratios of 50:50 and 33:33:33 and one fallow treatment. These treatments were repeated 5 times,
but randomized in the block designs. A detailed setup of the cover crops can be seen in Figure
3.2. On 2 April 2019, spring barley was planted. Thereafter, the plots were divided in half (10
m by 3 m each): one unfertilized and one fertilized with mineral N (60 kg N/ha) at the time of
barley sowing. On 23 July 2019, the spring barley was harvested. During the growing season,
there were no fertilizer related management activities.
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Figure 3.2: Detailed setup of the winter cover crop treatments of the Clever Cover Cropping experiment.

UAV Image Collection
Platform, Software and flight dates
For this study, the DJI Mavic Pro (Figure 3.3, left) quadcopter with its 12 MPix RGB camera
was used as UAV platform. The sensor attached to this UAV was the Parrot Sequoia
Multispectral sensor (Figure 3.3, right) with a camera of 16 MPix and a resolution of
2.88x2.88cm per pixel. The Parrot Sequoia measures in 4 spectral bands: Green (550nm), Red
(660nm), Red Edge (735nm), and Near Infrared (790nm). Between 1 April 2019 and 24 July
2019, 13 UAV flights were performed over the study area. However, 4 flights were excluded
for further analysis because the UAV did not manage to take images with GPS coordinates
during that flights, while this is crucial to stitch the images together and create an orthomosaic.
A detailed overview of the flight dates can be seen in Appendix A.
During this study different software programs were used. RStudio (R-3.6.3) was used for
programming. Agisoft Metashape (1.5.5.9097) was used for photogrammetric processing.
ArcGISPro (2.5.0) was used for visualizations.

Figure 3.3: DJI Mavic Pro in action (left). Parrot Sequoia Multispectral Sensor used for data acquisition (right).
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Artefacts during initial photogrammetric processing
The captured RGB and multispectral images were processed in an online portal of
Dronewerkers. Here, the raw data is processed into an orthomosaic, which is provided into a
GeoTIFF and PDF file within 24 hours. The portal makes use of Pix4D, a photogrammetric
stitching software using SfM. This resulted in three main products: reflectance per band, DSM
and a selection of vegetation indices. However, the processed data of the Dronewerkers portal
was of insufficient quality to do the research. In Appendix B, a part of that data is shown. In
this automatic way of processing raw data, it was not possible to include Ground Control
Points (GCPs). As a result, the output of the Dronewerkers portal did not have absolute
positioning information causing that it cannot be used for measurements or the comparison
with previous results. Therefore, it was decided to reprocess the raw data captured with the
Parrot Sequoia.
Radiometric calibration was done with the reflectance panel that belongs to the Parrot Sequoia
and the Sunshine sensor. Figure 3.4, left, shows the reflectance panel. In Agisoft the reflectance
values per band were applied on all images. However, due to an unknown error, it was not
possible to calibrate the reflectance for all image sets (Appendix A).

Figure 3.4: Reflectance panel (left). Parrot Sequoia Sunshine Sensor (right).

The Parrot Sequoia consists of the camera itself and a Sunshine sensor (Figure 3.4, right). This
is placed on top of the UAV and captures and logs the light condition when a photo is taken.
The function of the Sunshine sensor is to correct for changes in lighting conditions during a
UAV flight. When used correctly, this sensor can improve the radiometric quality of the data.
In Agisoft there is the option to use the logged sunshine sensor data and apply it on the UAV
images, together with the calibration of the reflectance panel. When this was done, it was
expected that this would benefit the calibrated images. However, in practice this turned out to
be false. Figure 3.5, top, shows an orthomosaic where the data of the Sunshine sensor is applied
on the images. It is clear that this product is not suitable for further analysis. Therefore, it was
decided to exclude the data of the Sunshine sensor during pre-processing. Figure 5, bottom,
shows the DEM of the same measurement date. Here the plots can be distinguished from their
surroundings.
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Figure 3.5: Orthomosaic of 14 June 2019 from Agisoft Metashape where Sunshine Sensor data was used (top). It is
not possible to see the plots and therefore use this product for analysis. Digital Surface Model of 14 June 2019
from Agisoft Metashape. The plots can be distinguished for the surroundings, and no strange patterns can be
seen.

Ground Data
Field measurements
Crop height measurements were collected 8 times during the barley growth period (Appendix
A). To monitor the barley growth rate by using non-destructive methods, the plant height was
measured. Measurements were taken in 10 randomly chosen plants of each plot, 4 times
during the barley growth period. The other 4 times only 5 plant replicates were measured per
plot. It is not clear on what location in the plots is measured. For more details, see the thesis
report of (Nascimento, 2019). Height measurements were taken from the soil to the highest
point of the crop, except for the first 2 measurement dates. There the height was measured
from the barley first auricle aboveground to reduce variability due to different sowing depths.
An important remark is that the field measurements were only done on the unfertilized parts
of the plots.
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Ground Control Points
On 14 February 2020, 10 Ground Control Points (GCPs) (Figure 3.6, left) were measured with
a Topcon RTK-GNSS positioning system. The main reason for this was to collect the absolute
X, Y and Z value of every GCP for accurate DEM processing. The surface was a white panel
with a black cross (Figure 3.6, right).

Figure 3.6: RGB Orthomosaic with an overview of the experiment and the location of the GCPs, acquired on 14
February 2020 (left). Ground Control Point on 14 February 2020 (right).

Combined UAV and field dates
The field measurements and UAV data of 3, 10 and 17 May will be used for the analysis
because these are measured on the same day. The measurements of 14 & 10 June and 19 & 16
June will also be used, even though there is a difference between the UAV flight date and field
measurement date here. This results in 5 observations that will be used for the analysis (Table
1).
Table 1: Combined UAV and field measurements dates that will be used to analyze the crop height.

1
2
3
4
5

UAV flight date
3 May
10 May
17 May
14 June
19 June

Field measurement date
3 May
10 May
17 May
10 June
16 June
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Methodology
The elaboration of the objective and answering of the research questions was done with the
method described in this chapter, where a visual overview and step-by-step description of the
methodology is given. A flowchart of the methodology is shown in Figure 3.7.

Figure 3.7: Flowchart describing the main steps of the methodology. The dashed frameworks indicate to which
research question it belongs.

Pre-processing
To get the products needed to be analysed, pre-processing of the raw UAV images was done
with Agisoft Metashape Professional, a photogrammetric stitching software using SfM. This
is a technique that makes it possible to reconstruct the measured surface to three-dimensional
structures and derive information from the generated point cloud, orthomosaic or elevation
model.
For every flight date the raw images were loaded into an Agisoft Photoscan project. After the
photos and GCPs were imported into the project, the photos were aligned and a mesh was
created based on these data. A manual check was needed whether the GCPs markers match
with the GCP panel visible in the UAV images (Figure 3.8). When this is done for all GCPs, it
allows for better model reconstruction results. Moreover, it prevents that the resulting output
has to be georeferenced manually. In the re-alignment step hereafter it is important that
Agisoft only uses the altitude of the GCPs to generate the DEM. This is done by unchecking
all cameras in the reference pane, and checking all markers. Based on these known reference
coordinates, the estimated point cloud can be optimized. This optimization adjusted the
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estimated point coordinates and camera parameters and therefore minimized the sum of
reprojection error and reference coordinate misalignment error (Agisoft, 2018).

Figure 3.8: Example where the marker, indicated with the label '3', does not match with the GCP panel on the left
side of the figure. The marker needs to be dragged to the GCP panel.

After alignment, radiometric and atmospheric calibration was performed on the images with
a reflectance panel. Hereafter the dense point cloud was created that formed the base for the
DEM and Orthomosaic consisting of the Green, Red, Red Edge and Near Infrared band, who
were exported into TIFF files. To make future work with photogrammetric processing easier,
a best-practice workflow was created (Appendix C) After pre-processing, the region-ofinterest polygons were drawn manually for each plot and clipped over the DEM, resulting in
a DEM with only data about the plots (Figure 3.9). A 10cm border was excluded from these
polygons to ensure that edge-effects were minimized.

Figure 3.9: Digital Elevaton Model masked and cropped with Region-Of-Interest polygons to get only plot-level
data

DTM assessment
The DEM of 1 April was used as DTM in the calculation of the crop height. Since it is included
in all calculations for the crop height, it can influence all these calculations both positive and
negative. To prevent that the data has a negative influence on the crop height, the dataset was
further examined to assess its quality. We had a look at the number of GCPs that were
successfully referenced to the DEM during pre-processing with Agisoft. Also histograms were
made of specific plots from the DEM data of 1 April and the nearest GCPs to assess the quality
of this dataset.
Another quality assessment of the DEM data of 1 April was performed using the ‘Actueel
Hoogtebestand Nederland’ (AHN) dataset where it was compared with. This is a dataset
containing the elevation of The Netherlands, acquired with an airborne LiDAR system. As a
result of this, it was decided to continue with the DEM of 1 April dataset and take the mean
value for every plot to calculate the crop height.
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Crop Height Model calculation
The crop height was derived from the CHM by subtracting the DTM from the DSM. Therefore
the following formula was used:
𝐶𝐻𝑀 = 𝐷𝑆𝑀 − 𝐷𝑇𝑀
In this formula the top of canopy value, consisting of the mean value of the 95 percent interval
of the corresponding plot was used as DSM, while the mean value of the DEM of 1 April was
used as DTM. This resulted in the crop height per plot. The calculation was done in the R
programming language.

DSM assessment
The DEM of the three measurement dates in May and two in June will be used as DSM in the
crop height calculation. A quality assessment was performed on these datasets to ensure that
they are of sufficient quality. A visual check on plot-level of the several DEMs was performed
and the crop height was calculated by subtracting it from the mean DEM value of 1 April on
plot-level to check if it came close to the crop height of the field measured corresponding plots.
Taking the mean DEM value of a specific plot to calculate the crop height did not result in a
representative value for the crop height. To ensure only vegetation was present in the data,
other objects and soil background had to be removed from it. This was done by calculating the
Normalized Difference Vegetation Index (NDVI) from the multiband orthomosaic images and
putting a threshold on it. Also, a 95% interval was taken to get the top of canopy layers (TOC).
After that, the mean was taken that gave a representative value for the crop height. The
equation of the NDVI is as follows:
(𝑁𝐼𝑅 − 𝑅𝑒𝑑)
(1)
𝑁𝐷𝑉𝐼 =
(𝑁𝐼𝑅 + 𝑅𝑒𝑑)

Crop height analysis
To analyse the correlation between the field measured crop height and the UAV derived crop
height, scatterplots were made. After that the R-Squared (R2) or coefficient of determination
was calculated. The R2 gives insight in how certain future outcomes can be predicted by the
model. This result can determine whether a correlation is present between the UAV derived
height and the field measurements. Another method to analyse the scatterplots is by
calculating the Root Mean Square Error (RMSE), formula (2). The RMSE gives the measure of
the error of a model. In this research, the RMSE is expressed in centimetres. Both the R-Squared
and RMSE give insight in the quality of the UAV derived data for the different dates. The
formula to calculate the RMSE is:
(2)
𝑛
1
2
𝑅𝑀𝑆𝐸 = √∑ (𝑦𝑖 − 𝑦̂𝑖)
𝑛
𝑖=1
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The scatterplots, R2 and RMSE were all calculated for the unfertilized plots. However, the UAV
did also capture the images of the fertilized plots. A disadvantage is that there are no field
measurements done on these plots. To analyse this data anyway, the method used to derive
crop height from UAV data for the unfertilized plots was extrapolated and run again on the
fertilized plots.
Looking at the plant-soil feedback approach, we also wanted to know how the different winter
treatments perform on the spring barley growth. Therefore the data was visualized in several
bar plots to provide insight into this. This was done per specific treatment for the UAV derived
height for the fertilized plots and unfertilized plots, and field measured height of the
unfertilized plots. Also bar plots were made of the mean value per treatment to see the height
development during the growing season.
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Results
In this chapter, the results are presented based on the methods described in the methodology
chapter. The results are presented based on the same order as the methodology. First, the
results of the DTM assessment are presented, followed by the DSM assessment and crop height
analysis.

DTM assessment
The DTM of 1 April was used to calculate the crop heights. To assess this DTM, it was
compared with the AHN (Appendix D). This comparison shows that the height distribution
of the DTM dataset follows the same pattern as the AHN3 dataset. As a result of that, there is
decided to continue with the DTM data and take the mean value for every plot to calculate the
crop height. Figure 4.1 shows the location of the GCPs with reference to the plots of the
experiment. The green color indicates whether a GCP was successfully georeferenced for the
DTM data of 1 April in Agisoft, the red color vice versa. The DTM of 1 April only contains the
elevation data of 5 GCPs. In the western part, only 1 of the possible 4 GCPs was matched
correctly, in the eastern part 4 of the possible 6 GCPs. As a result, there is more uncertainty
about the absolute height of the DTM data of 1 April in the most western part of the
experiment.

Figure 4.1: Overview of plot numbers and GCPs in the experiment. GCPs with the green color were successfully
referenced for the DTM data of 1 April, red vice versa.

In total 10 GCPs are located in the field. However, they were not all correctly referenced and
matched with the captured data of the Parrot Sequoia. This means that a few GCPs were not
visible in the from SfM photogrammetry derived imagery, and therefore could not be matched
with the ground-truth measured GCPs. As a result, the DTM does not include the data of these
GCPs, causing more uncertainty of the absolute height around these GCPs. GCP 1 and 10 are
the most western positioned GCPs in the experimental setup. Remarkable is that both GCPs
were never correctly referenced for all flying dates, as can be seen in Table 2.
Table 2: Overview of UAV flight date and the successfully referenced GCPs. Striking is that GCP 1 and 10 were
never successfully referenced, resulting in more uncertain heights in the western part of the experiment.

UAV flight
04-01
05-03
05-10
05-17
06-14
06-19

GCPs successfully referenced
3,5,7,8,9
2,3,4,5,8,9
2,3,4,5,8,9
2,3,4,5,8,9
2,3,4,5,7,8,9
2,3,4,5,8,9
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Figure 4.2 shows histograms of specific plots from the DTM data, together with the absolute
height of the GCP measured with the Topcon RTK-GNSS positioning system, indicated with
the red lines. The absolute height of GCP 1 and 10 is less than the DTM data, while GCP 3 and
8 are located within the range of the histogram values. As can be seen in Table 2, GCP 3 and 8
were successfully referenced in the DTM data, and thus represent the GCP height in the
histogram. All histograms of the DTM data with the plots and its nearest GCP can be seen in
Appendix E. They show that the height in the western part of the experiment is more uncertain
than in the eastern part, knowing that in the eastern part more GCPs were correctly referenced.
This, together with the fact that GCP 1 and 10 were never matched correctly, has led to the
decision to critically evaluate plot numbers 1 to 16 in the crop height analysis.

Figure 4.2: Histogram of DTM data of 1 April of plots 9, 10, 24, and 32, and the RTK measured height of its nearest
GCP, indicated with the red line. The height of GCP 1 and 10 is substantially lower than and out of the range of
the histogram values of its corresponding plot number. The height of GCP 3 and 8 is located within the range of its
corresponding histogram.

DSM assessment
A visual check on plot-level of the several DSMs was performed (Figure 4.3, left) and the crop
height was calculated by subtracting it from the mean DTM value of 1 April on plot-level to
check if it comes close to the crop height of the field measured corresponding plots. First, we
took the mean DSM value of a specific plot to calculate the crop height. However, this value
was too different from the field measured crop height (Table 3). Probably because soil was
included in the plot that influenced the mean value in such a way that it was not representative
for the crop height. Because we wanted to analyze only the crop height and not soil
background, the TOC pixels of the DSM were calculated by taking a 95 percent interval
threshold per plot. Although these values came close to the field measured crop height, this
unveiled the presence of cylinders (Figure 4.3, middle & right) in the plots that influenced the
DSM and had to be discarded. This was done by taking the multiband orthomosaic images,
calculating the NDVI (Figure 4.4, left) and setting a threshold of 0.1 on this NDVI (Figure 4.4,
middle), since these cylinders do nat have a high NDVI value. The resulting NDVI was
polygonised and masked over the DSM for the specific plot (Figure 4.4, right). Moreover, by
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setting this threshold value, the soil was also excluded from the DSM. It resulted in a DSM
without the presence of soil and cylinders, and thus only vegetation. Hereafter the 95 persent
interval again was taken to get the TOC layers (Table 3). Here the mean was taken from, that
gave a representative value.

Figure 4.3: Zoom in on the DSM data of 3 May of plot 24 of the experiment (left). 95 percent interval of
DSM for 3 May showing a high concentration of pixels on two spots for plot 24 (middle). RGB image on 3
May of plot 24 showing the presence of 2 cylinders in the plot (right).
Table 3: Different methods of calculated crop height in comparison with the field measured crop height for plot
24. The 95% interval on the DSM where soil and the cylinders were excluded is the closest to the field measured
crop height.

3 May
10 May
17 May
14 June
19 June

Mean
DSM (cm)
12.52
16.76
19.70
40.71
51.87

95% TOC
DSM (cm)
15.29
20.02
23.43
54.42
61.82

Mean DSM for
NDVI 0.1 (cm)
12.96
17.37
19.97
40.71
55.87

95% TOC DSM for
NDVI 0.1 (cm)
16.39
21.09
24.47
59.60
63.23

Field measured
crop height (cm)
17.2
22.3
25.6
60.3
57.6
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Figure 4.4: NDVI of plot 24 on 3 May (left), NDVI with a 0.1 threshold of plot 24 on 3 May (middle) and the
polygonised NDVI with the 0.1 threshold (right) of plot 24 for the DSM of 3 May.

Crop height analysis
After the crop height per plot was calculated, scatterplots were made to compare field
measured crop height with UAV derived crop height. Figure 4.5, left, shows the scatterplot of
the field measured crop height (x-axis) and the UAV derived crop height (y-axis) for 17 May
2019. The majority of plot numbers 1 to 16 are located below the trend, something we also saw
in the histograms of Figure 4.2. It looks like the UAV measured crop height is underestimating
the field measured crop height here. Figure 4.5, right, where the first 16 measurements were
excluded, shows that the other 24 observations follow the trendline better without these 16
observations. For the last measurement date in June, this effect is very different. Here, the first
16 observations are located around the trendline and between the other observations (Figure
4.6, left). Therefore, it shows a small effect on the scatterplot where these 16 observations were
excluded (Figure 4.6, right).

Figure 4.5: Scatterplot of field measured crop height(x) and UAV derived crop height (y) for the measurements of
17 May (left). The first 16 observations are almost all located under the trendline and influencing the scatterplot,
looking at its R2 and RMSE. The same scatterplot but with the first 16 observations excluded (right). This has a
noticeable effect on the R2 and RMSE.
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Figure 4.6: Scatterplot of field measured crop height (x) and UAV derived crop height (y) for the last
measurement date in June (left). The same scatterplot but with the first 16 observations excluded (right). It has a
small effect on the R2 and RMSE.

The scatterplots later in the growing season show the same pattern. The scatterplots of all
measurement dates are shown in Appendix F. To give this a value to make it comparable, the
RMSE and R2 for the scatterplots were calculated (Table 4). For the 3 measurement dates in
May, both the R2 and RMSE perform better when the first 16 observations are excluded (Figure
4.5 and Appendix F). To be consistent, the first 16 observations were excluded from all
measurement dates in further analysis. In addition, a scatterplot of all 120 observations used
in the analysis was made (Figure 4.7). This scatterplot has a R2 of 0.91 and a RMSE of 7.11 cm.
Early in the growing season, the values are more close to each other. However, later in the
growing season the observations are more fluctuating.
Table 4: RMSE and R2 for the scatterplots per measurement date with all 40 observations and with the first 16
observations excluded.

Date
3 May
10 May
17 May
14 & 10 June
19 & 16 June

RMSE
all points
4.77
6.85
11.62
9.9
6.05

RMSE
Excluded 16 points
2.53
3.30
2.93
10.48
6.37

R2
All points
0.037
0.0000011
0.05
0.58
0.56

R2 without first 16
0.13
0.18
0.57
0.51
0.54
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Figure 4.7: Scatterplots of all 120 observations used for analysis, categorized on date. The measurement dates are
clear to see when crop height increases. The 2 measurement dates in June show a more fluctuating pattern
comparing to the observations in May.

Treatment analysis
To check how the different winter treatments perform on the spring barley growth, a
comparison of height development in bar plots was made. This can give insight in the effect
of cover crops on the following summer crop. All bar plots can be seen in Appendix G.
In Figure 4.8, top, the crop height per treatment of 17 May are shown. The UAV derived crop
height for the unfertilized plots is substantially lower than the other two measured heights.
Also, differences per treatment show up. The Vetch x Radish (VR) treatment has a large crop
height in block 3 and 5, together with the Radish (R) treatment. Figure 4.8, middle, shows the
crop height per treatment for 14 June. Both UAV derived crop heights for block 5 are higher
than the manual derived crop height in comparison with the other blocks. In addition, the
UAV derived crop height of the unfertilized plots is for almost every treatment higher than
the field measured crop height. Only the fallow (Fal) treatment of the UAV derived crop height
for the unfertilized plots is lower than the field measured crop height. This is a conflicting
pattern compared with block 3 and 4. Figure 4.8, bottom, shows almost the same pattern as in
the bar plot of 14 June. However, here the UAV derived crop height for the unfertilized plots
increased relative to the crop height of 14 June. For the UAV Fertilized derived crop height,
the Fallow (Fal) and Oat (O) treatment have the smallest crop height. For the manual derived
crop height the Radish (R), Oat x Radish (OR), and Vetch x Radish (VR) treatment have the
largest crop height. Here, the Fallow (Fal) and Oat (O) treatment show the lowest values. The
UAV Unfertilized derived crop height is shorter than the UAV Fertilized derived crop height.
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Figure 4.8: Bar plots of the crop height of manual derived crop height and UAV derived crop height for the
unfertilized and fertilized plots for 17 May (top), 14 June (middle) and 19 June (bottom) per specific treatment and
block. Treatments are fallow (Fal), oat (O), radish (R), vetch (V) and different bi- and tri-mixtures of it. The full list
of acronyms can be seen in Figure 3.2.
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To get more insight into the development of the crop height over time, the measurements of
the three blocks were averaged and visualized in bar plots. Figure 4.9 shows the average crop
height over time for cover crops species grown as monoculture. Figure 4.10 shows the average
crop height for the bi- and tri-species mixture and the fallow treatment over time. The UAV
derived crop height for the fertilized plots in May has comparable values looking at the other
measured crop heights, but later in the growing season the crop height is substantial higher.
This is the case for every treatment. For both UAV derived and manual measured crop height,
the Radish winter treatment has the largest crop height for almost all measuring dates. There
are little differences in crop height per treatment early in May. For the measurement dates in
June, these differences are larger. In the early growing stages, the Fallow treatment has an
equal crop height compared with the other treatments. However, for the measurement dates
in June this treatment clearly has the lowest crop height. Overall, the manual unfertilized bar
plots show a decline in crop height between 14 June and 19 June for most of the treatments.
This is not the case for the UAV unfertilized bar plots, where an increase in crop height can be
seen. The bar plot of the fallow treatment shows a decrease of 1,5 cm for the manual
unfertilized crop height, while the UAV unfertilized crop height increases with 18.6 cm.
Despite that, the crop height for both measured crop heights on 19 June is comparable, where
there is a bigger difference for most of the other treatments.

Figure 4.9: Mean bar plots per cover crop monoculture for the different measurements over time.

32

Figure 4.10: Mean bar plots per cover crop bi- and tri-species mixture and the fallow treatment for the different
measurements over time.
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Discussion
UAV image collection & Pre-processing
The second research question was to investigate what workflow could be used to create the
best photogrammetric products in Agisoft Metashape. To create the best data products from
the raw UAV images, several options and processing parameters were evaluated, since these
parameters have a significant influence on the resulting accuracy. The most important
parameter proved to be the weights added to the imported GCPs and UAV images in Agisoft.
Since the GCPs are acquired with RTK accuracy they are the most accurate and therefore need
to get the highest weight. Moreover, the best model reconstruction results were generated
when no weights were added to the UAV images, and only the altitude of the imported GCPs
was used. After iteratively changing different parameters a best-practice Agisoft workflow
was created (Appendix C). This was done since there is no common, harmonized methodology
in the process chain (Ouédraogo et al., 2014). In the beginning this was a very time consuming
task, because only the local graphic card could be used of one PC. After discussing that, it was
possible to make use of the batch processing facilitated by Wageningen University and
Research. This batch processing made this process go faster. Thanks to that, it was possible to
run many Agisoft projects with different parameters.

Uncertainties in DTM
The accuracy of the DTM was very important since it was used in every calculation of crop
height. However, errors in surface models based on photogrammetric techniques are not
uncommon (Ouédraogo et al., 2014). In this study, the UAV data acquired on 1 April 2019, one
day before sowing, was used as DTM in the crop height calculation. A DTM directly after
sowing could also be used (Grenzdörffer, 2014). Other studies used different methods when a
DTM is lacking; by interpolating the areas between plots to retrieve a ground surface (Van Der
Meij et al., 2017) or airborne laser scanning (Martin et al., 2011).
Because the absolute X, Y and Z values of the GCPs in the study area were not present, the
data was acquired on 14 February 2020 with the Topcon RTK-GNSS positioning system. These
GCPs were used as a reference for every UAV flight. This was not the most ideal situation,
because it is not known what happened with these GCPs during the growing season.
Managing activities that took place on the field influence the detectability of GCPs with UAVs.
It could be that a tractor or harvest machine drove over the GCPs in the field, causing that the
GCP was pressed lower in the field. That can influence the altitude of the measured GCPs on
14 February. An important advantage of the GCPs is that the outcoming products do not have
to be georeferenced manually, reducing the chance for mistakes when the data was masked.
However, these GCPs were not always visible during the growing season, due to overgrown
vegetation or because they were not cleaned (Appendix H). It is known that the people from
Unifarm who acquired the UAV data were not aware of the effects of GCPs on the from
photogrammetry derived products (Unifarm, personal communication, 5 March 2020). Also,
it was not clear whose job it was to clean these GCPs.
For all processed UAV flights there were a few GCPs that could not be referenced correctly
(Table 2). This had dramatic effects for all elevation models since there was more uncertainty
around not correctly referenced GCPs. For this DTM data, only 5 GCPs were referenced
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correctly in Agisoft. To reach the best quality outputs, at least 10 correctly referenced GCPs
are required (Agisoft, 2018). That the lack of referenced GCPs in Agisoft led to more
uncertainty around these locations in the DTM, becomes clear in Figure 4.2. The height of
GCPs that are correctly referenced in Agisoft is located within the range of the histogram of
the DTM. The height of not correctly referenced GCPs was also relatively far from the
histogram values. This became clear for the most western laying GCPs; 1 and 10. The lack of
correctly referenced GCPs in Agisoft likely led to these results, and therefore to the decision
to remove plot numbers 1 to 16 from further analysis. This is a good example of the dramatic
effects of the lack of correctly referenced GCPs can have on the produced data.

Choices in DSM
Because of the presence of soil and other objects in the experimental plots, we had to find a
method to exclude them. First, the soil was excluded by taking the 95% interval and therefore
TOC layers of the vegetation. Other studies use comparable methods, for example by using a
two sigma threshold to take the top 2.3% (Van Der Voort, 2016), or use an interval between the
top of 95% to 99% as proposed by (Grenzdörffer, 2014).
The cylinders were discarded by calculating the NDVI and putting a threshold of 0.1 on that
(Figure 4.3 & Figure 4.4). A limitation here was that the multispectral output of the Agisoft
workflow was not calibrated correctly. Therefore, the quality of the calculated NDVI could not
be guaranteed. In Table 3, the different elevation values for plot 24 are shown. This clearly
shows the effect of the NDVI threshold that makes sure soil is excluded. Also the effect of the
95% TOC is visible. This is a good argument that the used methodology performs well.

Analysis of crop height
The scatterplots in Figure 4.5 clearly show the effect of the uncertainty in the DTM values.
Figure 4.5, left, shows that the first 16 plot numbers are located under the trendline, as they
have a very low UAV derived crop height. For a part of the measurements it is even negative.
As known from the DTM assessment, these first 16 plot numbers are all located in the western
part of the experimental setup, where not all GCPs were correctly referenced. Therefore, it is
very likely that the mismatch of GCPs led to more uncertainty in the DTM, resulting in also
more uncertainty in the calculated crop height. This, together with the findings in the DTM
assessment chapter, led to the decision to exclude these first 16 plot numbers from further
analysis.
In the scatterplot for the last measurement date in June (Figure 4.6) the first 16 plot numbers
do not show the large underestimation in UAV derived crop height. This is probably because
on this date there was no (or almost no) soil present in the experimental plots, only vegetation.
Also, the slope in the study area can play a role in this. From Appendix D it is known that
there is a slope of approximately 1 meter in the experiment from South-West to North-East.
Even though the GCPs in the western part of the setup were not correctly referenced, the
presence of the vegetation in the plots cover this. The RMSE and R2 also show this (Table 4).
Where both parameters vastly improve for all measurement dates in May, they stay the same
for the measurement dates in June. Because we wanted to be consistent in the crop height
analysis phase, the data of the first 16 plot numbers was also excluded here.
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The third research question was if the information derived from multispectral data is
comparable with ground truth measurements in all growing stages of spring barley, to
possibly replace them in the future. Therefore, all valid measurements were put together in a
scatterplot (Figure 4.7). Here, the division between the lower crop heights in May and higher
crop heights in June becomes clear. Also, a more fluctuating pattern in the crop height for the
measurements in June can be seen. Probably this is because of more variation in the crop height
for this date. However, with a R2 of 0.91 and a RMSE of 7.11 cm, the UAV derived crop height
fits quite well against manual measured crop height. A similar study was done by Bendig et
al., (2014) who compared plant height and UAV derived plant height for spring barley with a
R2 of 0.92 for different growing stages. In that study, 15 GCPs were used, ensuring the accuracy
of the terrain model.

Analysis of treatment effects on crop height
Bar plots were made to get insight into the effect of different treatments on the crop height. In
these plots, the UAV derived crop height for the fertilized plots were added. Since these plots
were fertilized, it was expected that the crop height would be larger here than for both
unfertilized derived crop heights. For the bar plots of 3 and 10 May (Appendix G), no or very
slight distinguishable effects in treatments can be seen. Here it is too early in the growing
season to draw conclusions from this.
In the bar plot of 17 May, small deviations in crop height start to appear for the different
treatments. Here, the difference between the UAV derived crop height for the fertilized and
unfertilized plots starts to increase. This pattern will continue further in the growing season.
The Radish treatment has the highest crop height on 17 May. Also, differences of +- 20
centimeters are measured here between the largest (Vetch x Radish UAV Fertilized) and
smallest (Fallow UAV Unfertilized) crop height.
Because there is a gap of 4 weeks between the third and fourth measurement date, the crop
height increased a lot in this period. The bar plots of 14 and 19 June show larger differences in
crop height. For both dates, block 5 has the largest crop heights for UAV fertilized and UAV
unfertilized, compared with the other blocks. From field observations it is known that block 5
is located around a more moist area than the other blocks (Unifarm, personal communication,
5 March 2020). By taking the drought and extreme heat of the summer of 2019 in account, this
could explain the larger crop height here (Trouw, 2019). The knowledge of the slope in the
study area and therefore higher DTM values around block 5, strengthens this thought.
However, the manual measured crop height is equal compared with the other blocks (Figure
4.8, bottom).
The fourth research question was focussing on the effects of the different cover crops on the
barley crop height as observed from multispectral UAV data. Therefore, the 3 blocks were
averaged and visualized in bar plots. The main findings from these bar plots are that mixtures
mainly have a larger crop height, together with the Radish treatment. Also, the fallow
treatment really lags behind with the other treatments. As expected, the UAV fertilized crop
height is almost always larger than the other two measured crop heights. Only early in the
growing season, it is sometimes equal or less than that. Remarkable is that the manual
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measured crop height decreases between the fourth and fifth measurement date, while this is
not the case for both UAV derived crop heights. The majority of the UAV Unfertilized crop
height is lower than the manual unfertilized measured crop height on the 4th measurement
date. This is a common founding in previous studies about high resolution aerial imagery for
crop type mapping (Wu et al., 2017).
On the fifth measurement date the UAV Unfertilized crop height is structurally higher than
the Manual Unfertilized crop height. A reason for that could be that different parts were
measured. From the UAV data, the mean of the top 5% of the TOC is shown. The method of
how the crop height was measured in the field was not consistent for all 8 measurement times.
In particular, 4 times the measurements were taken in 10 randomly chosen plants of each plot,
4 times 5 randomly chosen plants were measured per plot (Appendix A). However, the
location of these measurements was not clear, as well as what was measured. It is not clear if
for example only TOC layers were measured, or also barley plants with a lower height.

Limitations
UAV data was acquired with a Parrot Sequoia multispectral sensor attached on a DJI Mavic
Pro UAV. During the growing season of the barley crop, between 1 April 2019 and 24 July
2019, 13 UAV flights were performed. Due to an unknown error the GPS coordinates were not
attached to the images, so the data of 4 flights could not be used. Often, this was not known
during and after the flight. It became clear when the data was uploaded to the Dronewerkers
portal and an error message showing the GPS coordinates were lacking was received. As a
result, there were only 5 measurement dates that could be used to analyse the crop height,
with a gap of almost 4 weeks between the 3rd and 4th measurement date. The whole series of
13 processed UAV flights with the dronewerkers portal was of insufficient quality to start the
analysis with. Therefore, the raw UAV data had to be processed with Agisoft Metashape. After
that, region-of-interest polygons were manually drawn in ArcGISPro. Since this was done
manually, it is more sensitive for errors. This was covered by excluding a 10cm border.
In Agisoft Metashape there are a few steps to ensure the quality of the data. The first one is the
radiometric calibration of the UAV images. This can be done with the reflectance panel and
the sunshine sensor. The calibration with the reflectance panel failed for several flights, that
therefore could not be calibrated. However, in an interview with the people from Unifarm who
acquired the UAV data, it became clear that the images of the reflectance panel before a UAV
flight were used for several flights in a row to save time (Unifarm, personal communication, 5
March 2020). This could be a reason for the several calibration errors. The radiometric
calibration can also be done with the sunshine sensor. This sensor is attached on top of the
UAV and able to filter the incoming light and apply it on the UAV data. This is useful when
for example a UAV flight is performed with a partial cloud cover or changing atmospheric
conditions. However, due to an unknown reason the sunshine sensor was not working
correctly and logged the wrong values, making the sensor useless for calibration because it
resulted in just more noise (Figure 3.5). The processing of the raw UAV data was a time
consuming job and not planned beforehand. Therefore, choices had to be made during this
study as it was not possible to work out all points as proposed beforehand.
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The field measurements were done 8 times during the barley growth period. However, the
people from Unifarm and the student did not know from each other that they were acquiring
data for this thesis because that was decided later. If it was known beforehand, the field
measurements and UAV data acquisition could have been arranged, so there was for example
consistent information of every week. Luckily for the 3 measurement dates in May both
measurements were on the same date, for the other 2 in June there was a gap of a few days
inbetween.
When the crop height was calculated, it became clear that the lack of correctly referenced GCPs
caused problems for the calculated crop height. Plot numbers 1 to 16 had a huge deviation in
crop height, as can be seen in Figure 4.5. This was mainly the case for the 3 measurement dates
in May. For the measurement dates in June, the crop height of plot numbers 1 to 16 was not
divergent. An explanation for this could be that in June the plots were almost fully covered
with vegetation, where this was not the case for all measurement dates in May. However, due
to the uncertainty in the western part of the DTM and to be consistent, these measurements
were still excluded from further analysis. Due to the issues with the GCPs that could not be
referenced correctly in Agisoft Metashape, block 1 and 2 in the western part of the experiment
had to be discarded from further analysis. This meant that the number of plots that could be
analyzed decreased from 40 to 24.

Recommendations
In a future similar project, organization and a clear division of tasks is important to acheve a
good quality dataset, since this was not the case during this project. A good example was the
cleaning of GCPs before a UAV flight. This had dramatic effects on the used data during this
study. To prevent this in future projects, agreements beforehand should be made. Also, it is
recommended that field measurements and UAV data acquisition happens on the same date
to have consistent information from both sources, as this was not always the case in this study.
The scope of this study was to look at the from SfM photogrammetry derived Digital Elevation
Models. However, the Parrot Sequoia used for data acquisition also captures data in four
spectral bands that were only used for a little part in this study. It would be a good addition
to also make use of this data and have a deeper look at it, because the resulting vegetation
indices can give valuable information about the crop’s condition.
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Conclusion
In this research, the use of multispectral UAV data was investigated to get insight in all crop
growth stages of spring barley and examine the effects of cover crop treatments in the context
of the PSF. The aim of the research was to investigate the accuracy of UAV derived crop height
compared with ground-truth crop height and if there is a specific cover crop where the spring
barley performs best on. With SfM photogrammetry 3D elevation models of the crop height
were created from the 2D multispectral images. In total 24 plots were analyzed 5 times during
the barley growth period.
To calculate the crop height, the DTM was distracted from the DSM. The UAV data of 1 April,
1 day before sowing, was used as DTM. Compared with the AHN this DTM followed the same
pattern. However, the need of correctly usage of GCPs became clear when it was compared
with the absolute height of GCPs. Locations where the GCPs were not correctly referenced
during photogrammetric processing, turned out to be too unreliable to calculate crop height
with. The accuracy of UAV derived crop height highly depends on ground-truth information
available and the possibility to match them in photogrammetric software. This was not the
case for such a number of GCPs, resulting in more uncertainty around these locations. The
cause of this is that the GCPs were not visible during UAV flights, making it impossible to
match them correctly. However, the methodology to first exclude objects in the field with a
threshold on the NDVI and thereafter a threshold on the crop height to get the TOC layers
proved to be good and reproducible.
In all growing stages the UAV derived crop height has a correlation of R2 = 0.91 and a RMSE
of 7.11 centimeters compared with the ground-truth information. However, there is a large
difference between measurements in May, where the maximum RMSE equals 3.30 centimeters,
and in June, where the maximum RMSE equals 10.48 centimeters. However, this could be
expected since crop height starts to vary more at larger heights.
The use of different cover crops in winter does make differences in spring barley height. Where
it is very difficult to distinguish for all measurements in May, larger differences can be seen in
June. Bar plots show that mixtures of cover crops and the radish cover crop have the largest
crop height. Also, the fallow treatment has the lowest crop height in almost all growing stages.
The bar plots show that it is possible to see differences in crop height for treatments, and UAV
derived crop height and ground-truth information often shows similar values.
This study showed the effects of different cover crops on spring barley height. Due to several
issues with the acquired data, the best was made of it. As a result, the usefulness of good data
acquisition became very clear. With this in mind, this study looks promising, as results will
only be better in the future if good data can be used.
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Appendixes
Appendix A
Table 5: Overview of field measurement days and number of replicates per plot.

Barley measurements
1
2
3
4
5
6
7
8

Dates
18 April
3 May
10 May
17 May
27 May
4 June
10 June
16 June

Replicates per plot
10
10
5
5
10
5
5
10

Table 6: Overview of flight dates together with the amount of pictures taken by the Parrot Sequoia, information
about the performed radiometric calibration and extra comments.

Date

Pictures taken

1 April
3 May
10 May
17 May
14 June
19 June
2 July
16 July
24 July

655
510
461
459
265
527
378
402
373

Radiometric
calibration
Can’t calibrate
Can’t calibrate
Calibrated
Can’t calibrate
Calibrated
Can’t calibrate
Calibrated
Can’t calibrate
Can’t calibrate

Comment
Day before sowing

Day after harvesting
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Appendix B

Orthomosaic with band combination 1 (Green) - 4 (NIR) - 3 (RedEdge) for 19 June 2019. As an example
of the insufficient quality, the yellow circle multiple plots can be seen.

Digital Elevation Model from the Dronewerkers portal of 14 June 2019. Plots are visible, but also a clear line of
noise causing that the data is not suitable for analysis.
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Appendix C
Agisoft workflow and parameters used during pre-processing
The following Agisoft Metashape 1.5.5.9097 workflow and parameters were applied on all raw
datasets of this study.
Step 1: Add the photos and Ground Control Points to the Agisoft Project.
Upload the folder with the images of the Parrot Sequoia by clicking Workspace → Right click
Chuck → Add → Add Folder
Upload a .csv file with the exact location of the GCPs measured with an RTK system.
- Add the .csv file by clicking Import in the Reference pane
- Set the right coordinate system; WGS 84(EPSG::4326)
Step 2: Calibrate reflectance
Click Tools → Calibrate reflectance → Locate panel.
If this gives an error, fill in the right values in the Panel Calibration tab
Green
0.177
Red
0.214
Red edge
0.266
NIR
0.368
In the parameter tab check Use reflectance panels → Click OK
Step 3: Align photos
Accuracy:
Highest
Reference preselection:
Yes
Key point limit
40,000
Tie point limit
4,000
Adaptive camera model fitting
No
Step 4: Upload coordinates of Ground Control Points
Upload a .csv file with the exact location of the GCPs measured with an RTK system.
- Add the .csv file by clicking Import in the Reference pane
- Set the right coordinate system; WGS 84(EPSG::4326)
Step 5: Manual marker check
- Check if the Agisoft markers match with the Ground Control Points in the pictures.
- Right-click on a marker and click Filter by Marker. Agisoft shows only the pictures
where this marker and corresponding Ground Control Point are in located. If needed,
move the marker to the corresponding GCP. The blue flag of the marker will change to
green.
- To this for all images and all markers
- After that, click Update
Step 6: Optimize alignment
Parameters
f, b1, b2, cx, cy, k1-k3, p1, p2
Adaptive camera model fitting

No

Step 7: Build Dense Cloud
46

Quality
Filtering mode
Reuse depth maps
Calculate point colours
Step 8: Build DEM
Source data
Interpolation
Point classes
Step 9: Build Orthomosaic
Blending mode
Surface
Enable hole filling

Ultra High
Mild
No
Yes

Dense cloud
Enabled (default)
All

Mosaic
DEM
Yes

Step 10: Raster transform
Click Tools → Set Raster Transform
Make sure your Raster Calculator looks like this:

This is to normalize the output bands to a 0-1 interval and make it possible to calculate
vegetation indices.
Step 11: Export Orthomosaic & DEM
Click File → Export → Export Orthomosaic → Export JPEG/TIFF/PNG..
- Make sure that in the Export Orthomosaic dialog Index Color is selected in the Raster
Transform section
- choose TIFF and give the file a destination.
Click File → Export → Export DEM → Export TIFF.. and give the file a destination
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Appendix E

Some of them were overgrown with vegetation, causing that they were not visible anymore
on the UAV image.
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Appendix F
Scatterplots 3 May
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Scatterplots 10 May
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Scatterplots 17 May
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Scatterplots 10 & 14 June
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Scatterplots 16 & 19 June
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55

56

57

Appendix H

58

